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Welcome to the
2003 Edition of
World Book!
The 2003 Edition of the World Book Multimedia Encyclopedia,
the richest, most media-packed version we have ever made,
has been enhanced to take full advantage of Apple’s new Mac
OS X 10.2 operating system.

From collaborative research enabled by Rendezvous
technology to the amazing new 3-D globe and “waterstream”
Home Screen, this 2003 Edition of World Book presents an
invitation to explore. The journey begins here!

Top Ten New
Features
Rendezvous Sticky Notes

Taking advantage of Rendezvous, Apple’s new
automatic network technology, you can instantly
and automatically share your “sticky note”
bookmarks and research with others. (See page 4.)

3-D Interactive Globe

Using satellite photography, the new World Book
translucent globe gives you an astronaut’s-eye view
of Earth as it looks from outer space. (See page 13.)

Just Looking by Theme

We have enhanced World Book’s popular Just
Looking browsing tool with preset “themes” such
as Sport Heroes, Famous Women, European
Painting, Dinosaurs, Explorers, and more. (See
page 11.)

Just Listening

A completely new feature, Just Listening gathers
World Book’s rich collection of music and sounds
into themes from national anthems to bird calls.
(See page 12.)

Speech Capabilities

The World Book Speech Capabilities in this edition
allow you to navigate World Book by voice and
have articles read aloud to you. (See page 20.)

Spinning Dock Icon

World Book’s application icon in the dock will start
spinning when article updates or new media are
ready to be downloaded to keep your copy of
World Book up to date. (See page 16.)

Enhanced Notepad

The World Book Notepad word processor has been
enhanced with new features such as page breaks,
margins, spell-checking-as-you-type, send as e-mail,
resize graphics, and more. (See page 18.)

“Waterstream” Home Screen

Through the power of Mac OS X, the “water” on
the new World Book Home Screen appears to
move and media floats by like leaves in a stream.
Click on the screen and ripples go out like a stone
dropped in a pond. (See page 3.)

World Book Screen Saver

A fully customizable screen saver sends World
Book’s rich media collection floating and spinning
across your screen when your Mac is idle for a
while. (See “Appearance pane,” page 3.)

Surf the Ages

The successful “Surf ” feature has been expanded
to include new fictional Web sites as far back as
3500 B.C. (See page 17.)
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Getting Started
To launch World Book, double-click the World Book

application icon which you will find in the World Book 2003

folder inside the main Applications folder in your hard drive.

You may want to drag the World Book icon to the dock
so that it is easy to find for future launches.

The first time you launch the application you will see the

License Agreement dialog. Click Agree or Disagree in the

License window.

Note: You must view and agree to the License Agreement to

use World Book.

Registration
Registering your copy of World Book makes you eligible to
receive product alerts, special offers, updates, and news about
the World Book 2003 Edition. To find out how to register your
copy of World Book, choose Register World Book from the
World Book application menu.

Technical Support
If you experience any problems using the World Book 2003
Edition, visit the World Book Technical Support Web site
which can be reached by choosing World Book Tech
Support from the World Book application menu or by
entering
http://www.mackiev.com/wb2003/support.html
in your Web browser.

Contacting Technical Support

You may contact technical support by e-mail at
macsupport@worldbook.com. When contacting Technical
Support, please let them know you are using version 7.1.1 of
the World Book 2003 Edition.

Please also include the following information in your e-mail:

• version of Mac OS X you are running (for example, 10.2.2)

• your installed memory (for example, 256 MB RAM)

• your Macintosh model name (for example, iBook 700 MHz)

• exact text of any error message(s) that appear

Please also include information about your printer model if
the problem is printing-related (for example, Epson 740).

Customer Service
For assistance with questions and inquiries other than
technical support needs, please contact Customer Service by
e-mail at: macsupport@worldbook.com.

mailto:macsupport@worldbook.com
mailto:macsupport@worldbook.com
http://www.mackiev.com/wb2003/support.html
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Controls and
Functions

Home Screen

See indicated page(s) for more information.

Waterstream Media—click once

Click any of the video clips and pictures floating across the
bottom of the Home Screen to find out more about them in
the Media Center.

Home Screen Music

You may select music themes and other sounds to play on the
Home Screen using the Just Listening feature (p.12). You can
set the music that plays at startup on the Home Screen in
World Book Preferences.

The Home Screen media elements change to match the
theme selected in Just Listening. For example, if you select
African Music, pictures of people and places in Africa will
appear in the waterstream.

Search—click once

• Topics—Search by Topic (p. 6)

• Dictionary (p. 7)

• Atlas (p. 13)

• Time Frame (p. 14)

• What’s Online (p. 16)

Menu Bar

World Book menu

About World Book: Choose to view product credits and
acknowledgments.

Contributors: Choose to view alphabetical lists of World Book
contributors.

Install Media CD Contents: Choose to install all the contents
of the World Book Media CD that came with your computer as
an alternative to having the Media CD in your CD drive.

Register World Book: Choose to find out how to register
your copy of World Book. Registration enables you to receive
special offers, updates, and news about future editions.

World Book Speech Technology: Choose to learn about the
ongoing development of World Book speech technologies
which enable vision-impaired users to access World Book
articles using voice recognition and speech synthesis.

World Book Tech Support: Choose for product updates and
answers to Frequently Asked Questions posted on the World
Book Technical Support Web site.

Preferences: Choose to open World Book preferences to
customize your copy of World Book.

• General pane: To save your History List between
sessions, set the number of items that appear in the
History List (from 10 to 250), set the number of visited
places that will be shown in the Backward and Forward
drop-down menus, set the startup music, and activate
Sticky Notes sharing via Rendezvous.

• Appearance pane: To turn off the Waterstream effect
on Home Screen, animation effect on maps, set toolbar
and spin options for Bubble Views, retain all window
positions between sessions, and set up the World Book
screen saver.

Browse—click once

• Just Looking (p. 11)

• Just Listening (p. 12)

• Media Center (p. 10)

• Monthly Spotlight (p. 9)

• Surf the Ages (p. 17)

Click once

• Update Now to download updates (p. 16)

• Homework Wizards (p. 21)
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• Updates pane: To change the way World Book checks
for Article updates and the way World Book notifies you
when updates become available.

• Speech pane: To turn World Book’s Speech features on
or off ( Voice Recognition and Speech Synthesis) and
choose when to get spoken feedback from World Book—
always, or only in response to World Book voice
commands. From here you may also read some helpful
tips for using World Book Speakable Items and open the
Speech pane in your computer’s System Preferences.

File menu

Save: Choose to save the article in view. Note that all articles
are saved in a special World Book text format (*.wbt), which
can be opened in most Macintosh word processing programs
including the World Book Notepad.

Page Setup: Choose to adjust your printer settings.

Print: Choose to print World Book content. When in the
Article area, selecting
Print opens a dialog with
a list of items that can be
printed, such as article
text and graphics. You can
also print tables,
dictionary entries, search
results, and maps, as well
as most illustrations, photos, and their captions.

Edit menu

Copy: Choose to copy any currently selected text to the
Clipboard. Text appearing in the following windows can be
selected and copied: Article, Article Update, Caption, Sticky
Note, Table, Dictionary, Month in Brief, and Web Sites. You
may also copy any text in Surf the Ages that you are able to
select. Only one block of text may be selected at a time in any
one window. You may also copy most pictures, maps, and
illustrations to the clipboard in order to paste them into
layout and word processing programs. To do this, choose
Copy from the Edit menu when a picture or other multimedia
item is in view.

In the Media Center and in the Atlas area, you may need
to click media elements to select them before copying.

Select All: Choose to select all the text in a window.

Find: Choose to find words you want to locate in the article
in view. You can also use Find to look for words on any
simulated Web page in Surf the Ages that has selectable text.

Find Next: Choose to advance to the next instance of the
search word.

Use Selection for Find: Choose to locate additional
instances of a word you have selected in an article.

Speech: Choose to start, stop, pause, or resume the use of
Apple’s text-to-speech capabilities to hear the text of the
current article read aloud.

Article menu

Text Size: Choose to view and change the text size used in
the articles.

Turn Highlighter On: Choose to enable highlighting. When
the Highlighter is turned on, the cursor changes to a
highlighter shape when it passes over any article text that may
be highlighted. When you select this menu item, it changes to
Turn Highlighter Off.

Rotate Highlighter Color: Choose to rotate the highlighter
color to the next color in the list of four colors: yellow, pink,
blue, and green.

Highlighter Color: Choose to change the color of
highlighting.

Clear Highlights From Current Article: Choose to erase
all your highlights from the current article.

Clear Highlights From All Articles: Choose to erase all
your highlights throughout World Book.

Sticky Notes menu

New Sticky Note: Choose to create a new sticky note to
place in the currently open article, media, or map. The new
sticky note is open when created so that you can enter text.
You place the sticky note by clicking the close box in the
upper left corner or by choosing Close from the File menu.
You may create as many sticky notes as you like in the Article
area, but only one sticky note for each media item in the
Media Center and for each map in the Atlas area.

Open Selection in Sticky Note: Choose to create a new
sticky note that contains the currently highlighted text.

Delete Sticky Note: Choose to delete an open sticky note. If
you have more than one sticky note open, you should select
the sticky note you want to delete by clicking on it once
before using this command. You may also delete a sticky note
by dragging it to the trash.

Sticky Note Text Style: Choose to use bold, italic, or
underlined text styles in an open sticky note.

Set Sticky Note Color: Choose to change the color of an
open sticky note.
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Sticky Notes List:
Choose to view a list of
your sticky notes. You
may organize your sticky
notes in folders and
change their colors.

• Go to a sticky
note’s location by
double-clicking it in
the Sticky Notes
List. If you hold
down the Option
key when you
double-click, the
sticky note will be opened when you arrive at its location.
The Sticky Notes List will remain open so that you can go
to the locations of other sticky notes. Note that the icons
in the Sticky Notes List indicate whether they are
marking the location of an article, sound, picture, video,
animation, Bubble View, or map.

• Delete a sticky note by selecting it and pressing the
Delete key. You may also click the Delete icon on the
Sticky Notes List toolbar.

• Add an organizing folder by clicking the folder icon
on the Sticky Notes List toolbar.

• Organize your sticky notes by dragging them into
folders.

• Change a sticky note’s color by selecting it in the list
and choosing a new color in the color pop-up menu on
the Sticky Notes List toolbar.

• Change the color of all the sticky notes in a folder
by selecting the folder when choosing a new color.

• Share sticky notes using Rendezvous by clicking the
“Share My Sticky Notes” checkbox on the General pane
of World Book Preferences. When another person using
the 2003 Edition of World Book—who also has elected to
share sticky notes—enters your ethernet or airport
network, all his or her sticky notes with special network
icon will appear in your articles, media items, or maps,
and a Shared Sticky Notes area will appear at the bottom
of your Sticky Notes List. This window area will contain a
folder containing all the sticky notes in the other
person’s Sticky Notes List.

• View a shared sticky note by double-clicking it in the
Shared Sticky Notes List, and then clicking the Shared
Sticky Notes marker that appears in the Article area,
Media Center, or Atlas area. If you hold down the Option
key when you double-click the item in the Shared Sticky
Notes List, the sticky note will be opened when you
arrive at its location.

• Copy shared sticky notes by dragging them into your
own Sticky Notes List. Shared sticky notes that you copy
will contain the name of the other person’s computer
and the current date. If you don’t copy them, shared
sticky notes will disappear when you or the owner of the
shared sticky notes leaves the network.

Go menu

Back: Choose to go back one screen at a time.

Forward: Choose to go to the next screen.

History: Choose to see a list of resources you have used
during your current World Book session.

History List: Choose to open a list of World Book resources
you have used with the most recently used resources at the
top of the list. Note that icons preceding each resource in the
list indicate in which World Book area the resource was found
or, for Media Center resources, the type of media (picture,
sound, Bubble View, video, or animation.)

• Go to a History List item’s location by double-
clicking any item in the list.

• Retain your History List between sessions by
selecting this option on the General pane of World Book
Preferences.

• Set the number of items displayed in the History List
from 10 to 250 on the General pane of World Book
Preferences.

• Clear all History List items by clicking the Clear
History button at the bottom of the History List window.

Home Screen: Choose to return to the Home Screen.

Monthly Spotlight: Choose to see timely information in the
current “Spotlight On...” article.

Article: Choose to go to the Article area.

Media: Choose to go to the Media Center.

Just Looking: Choose to go to the Just Looking area.

Atlas: Choose to go to the World Book Atlas area.

Time Frame: Choose to make a chronological search using
the Time Frame feature. My Sticky Note Shared Sticky Note
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What’s Online: Choose to explore online features.

Surf the Ages: Choose to browse simulated Web sites. An
Internet connection is required only for links from this feature
to actual Web sites.

Tools menu:

Search: Choose to open the Search window, which enables
you to search for an article or media resource. You can also
open the Search window by clicking the Search icon on the
Toolbar.

Dictionary: Choose to find the definition of a word in a
World Book article or a word you type in. Double-clicking a
word in an article, caption, or pop-up tip automatically opens
the Dictionary window with the definition of that word on
display.

Homework Wizards: Choose to select from four
applications designed to help students with common
homework assignments. Homework Wizards can also be
launched from the Home Screen and the Toolbar (p. 21).

World Book Notepad: Choose to open World Book’s own
customizable word processor (p. 18).

Map Search: Click to open the Map Search window in the
World Book Atlas area (p.13).

Distance Calculator: Click to launch the World Book 3-D
Atlas application with the Distance Calculator view selected.
Here you can calculate the distance between selected cities
and display them on the World Book 3-D Globe and world
map (p. 13).

Toolbar

The fifteen Toolbar options are displayed in three groups. To
the left of the screen are the Tools icons: Search, Dictionary,
Sticky Notes, Highlighter, and Homework Wizards. In the
center are Navigation Control icons: Back, Forward, and
Home. To the right are the Area icons, representing places in
World Book that you can visit: Article Viewer, Media Center,
Just Looking, Atlas, Time Frame, What’s Online, and Surf the
Ages. The Toolbar is always available (except on the Home
Screen), making it easy to navigate.

Tools icons

There are five Tools icons:

Search: Click for the following capabilities:

• Search By Topic: This is the most common search
method. Type your topic
in the enter field and
press Return to begin
the search. The most
suitable match will be
highlighted in the search
results list and appear in
the article display area. If
no match is found for
your search term, a
keyword search is
automatically
performed. If no match
is found in either the
topic or keyword search,
an alert appears. Trying a
synonym for your term
may help. Double-clicking closed file folder icons next to
items in the search results list opens them to reveal
subtopics.

• Search By Word: Type your search words into the three
entry fields at the top of
the window. To refine
your search, you can use
the and/or/not pop-up
menus to combine the
search terms or search
according to the
proximity of the terms.
You can also limit your
search to certain types of
media by clicking the
disclosure triangle next
to Advanced Search and
checking all the boxes
that apply.

• Wildcards: You can use
“wildcards” to search for
more than one form of a word. A question mark ( ? )
represents a single character and an asterisk ( * )
represents one or more characters. You may use
wildcards at any place in a word, but you can only use
one wildcard per search. Click Go or press Return to
begin the search. Matches will appear in a Wildcard Word
List. To retrieve an item, click to highlight it, then click
Go. The search term(s) you used will appear in red in the
corresponding articles.
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the cursor will look like a highlighter pen that matches the
current highlight color.

You can highlight text by selecting it while the Highlighter
mode is on. You can erase highlights of the same color as the
cursor by reselecting the highlighted portion. You can erase
any color highlighting by entering Eraser mode. To do this,
select the Eraser from the Highlighter drop-down menu on
the Toolbar. When Eraser mode is on, the cursor will look like
an eraser. You can also remove all the highlights from the
current article, or all of the highlights you have made in World
Book, by choosing Clear Highlights items from the Article
menu.

Homework Wizards: Click to choose from four applications
designed to help students with common homework
assignments.

• Report Wizard for report writing guidance (p. 21).

• Chart Wizard for creating custom charts (p. 21).

• Timeline Wizard for building custom timelines (p. 22).

• Quiz Wizard for making and taking quizzes (p. 23).

You can also select a Homework Wizard from the Wizard
Toolbar icon drop-down menu.

Navigation icons

There are three Toolbar icons for navigation within World
Book:

Back: Click to back up one screen at a time. Click and hold
down the mouse button to choose a recently visited screen
from the Back icon drop-down list on the Toolbar.

Forward: Click to advance one screen, if available. Click and
hold down the mouse button to choose a screen from the
Forward icon drop-down list.

Home: Click to return to the Home Screen.

Area icons

Seven Toolbar icons allow you to quickly move to different
areas of World Book.

Article: Click to go to the Article viewer (p. 9).

Drag-and-Drop Tip: When you drag any word from an
article, a table, the dictionary, or Surf the Ages to the Search
icon on the Toolbar, the Search window will open and a
search will be automatically performed.

Dictionary: Click the Dictionary icon on the Toolbar, then
enter a word to look up. Click Go or press Return to see the
definition. To display a list of words starting with the same
letters, click Word List. The Dictionary window retains the last
word looked up. Click the blue drop-down control to see a list
of words that were looked up during the current session.

You also can look up any word in an article, caption,
pop-up tip, or dictionary entry simply by double-clicking the
word.

Sticky Notes: Click the sticky note icon on the Toolbar to
create a new sticky note. Click and hold down the mouse
button when clicking the Toolbar icon to choose a color for
the next new sticky note. You can edit, delete, place, resize,
and move sticky notes. It is also possible to change any sticky
note text to bold, italic, or underlined style by selecting the
text and choosing Sticky Note Text Style from the Sticky Notes
menu. Click a sticky note icon to reopen the placed sticky
note. Drag the sticky note icon to reposition the note in the
article. To remove a sticky note, open it and choose the Delete
Sticky Note command from the Sticky Notes menu or drag the
closed sticky note icon to the trash.

Drag-and-Drop Tip: You can copy any article text into
an open sticky note using drag and drop.

Drag-and-Drop Tip: You can copy the content of a
closed sticky note into TextEdit or the World Book Notepad
by dragging the sticky note icon into an open document
window.

You can delete a closed sticky note by dragging its
sticky note icon to the Trash. You can also delete a closed
sticky note by Control-clicking its sticky note icon and
choosing Delete Sticky Note from the contextual menu.

Highlighter: Click to turn Highlighter mode on or off. The
initial highlighting color is yellow. You can choose another
color of highlighter from the Highlighter Toolbar icon drop-
down menu. Only article text can be highlighted, but there is
no limit to the number of blocks of text that can be
highlighted at a time. A single word is the smallest element
that can be highlighted. Highlights remain from session to
session until you clear them. When Highlighter mode is on,
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Media: Click to go to the Media Center (p. 10).

Just Looking: Click to use Just Looking (p. 11).

Atlas: Click to go to the map viewing area (p. 13).

Time Frame: Click to make a chronological search using the
Time Frame feature (p. 14).

What’s Online: Click to explore online features (p. 16).

Surf the Ages: Click to view simulated Web sites covering the
past 5,500 years (p. 17).
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Article
The Article area of World Book is where you view articles,
related information (installed or online), and media
thumbnails, such as those for pictures and videos. To get to
the Article screen from the Home Screen, choose Monthly
Spotlight from Browse, or choose Topics or Dictionary from
Search. When you want to go to the Article screen from other
areas of World Book, click the Article icon on the Toolbar or
click the Go to Article button, if available.

Note: “Thumbnails” are mentioned in the Article, Just
Looking, and Time Frame sections of this User Guide.
Thumbnails are small windows containing pictures or text
that appear in a variety of World Book areas. You can click
the thumbnails to view the corresponding World Book media
elements or articles.

 To find out what topic corresponds to a particular
thumbnail, pass your cursor over the thumbnail and read
the text that appears in the Status Area at the bottom of the
main World Book window.

Article Controls

Tables: Tables are opened by clicking the Tables
icon (when present). Tables appear in the Table
Viewer. Most tables preserve their headings as you

scroll. Click Footnotes in an open table to toggle footnotes on
and off. Click Go to Article to go to the article associated with
the table. Click Enlarge Table to widen the table and Reduce
Table to narrow it again. You may also drag the vertical gray
resize bar to set the table to a convenient width.

 If you select and copy a table, it can be pasted into a
spreadsheet. Its table format will be maintained!

Audio: Click this icon, when it appears, to hear
related sounds. A pop-up caption will also appear.

Timeline: Click this icon, when it appears, to view a
related chronology. Toggle between Banner View
(horizontal) and Compact View (vertical) by clicking
on the corresponding tabs in the Timeline window.

Drag-and-Drop Tip:  You can drag and drop any
Timeline to your desktop to make a copy of it that you can
view even when World Book is not open.

Sticky Notes: Click these marker icons, when they
appear in an article, to view the related sticky notes.

Media Thumbnail: Click any of these small pictures in a blue
frame to move to the Media Center for an expanded view.

Article Outline: Click this control to see a window with
article contents by headings which appear at the left of the
screen. Click any item in the outline and the article will
automatically scroll to that section. When you scroll the
article, the outline scrolls in tandem with it.

 You can jump to the full-size version of any picture,
map, movie, animation, or Bubble View by double-clicking
its icon in the Article Outline window.

Related Info: Installed: Click this control for a list of related
World Book articles. Double-click any article title in the list to
open the article.

Related Info: Online: Click this control for a list of related
World Book online resources, including Web sites selected by
World Book editors. These resources are listed by category
and are described in the What’s Online section of this manual
(p. 16): Back in Time, Special Reports, Web Sites, and Article
Updates.

Article Media canister: Click this control to
unroll a “filmstrip” showing all media
elements related to the article in view. Place

the cursor over any item in the filmstrip to see a help tag with
its name. Click any item to move to the section of the article
containing the corresponding thumbnail, or double-click any
item to open it directly. Click the canister or the tab at the end
of the filmstrip to retract the filmstrip. When the filmstrip is
extended, click the right and left icon arrows to move the
filmstrip up/down one picture at a time. If an article does not
contain any media, this control will be grayed out.

Monthly Spotlight: The “Spotlight On...” article appears
when you choose Monthly Spotlight from the Home Screen
or from the Go menu. “Spotlight On...” is an article for you to
browse; it changes automatically each month (online
connection not required), with highlights from World Book
and interesting facts about the month.

Keyboard navigation: You can use your keyboard to
navigate within the Article area:

• Page Up/Page Down—up or down one screen

• Up Arrow/Down Arrow—up or down one line

• Home/End—to beginning or end of the article
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Media Center
All videos, animations, pictures, and Bubble Views appear in
the Media Center. All the sounds found in Articles may also be
played in the Media Center.

Media Center Controls

Reduce/Enlarge Image: Click to reduce/enlarge a video or
animation.

Instructions: Click for tips on using World Book media.

Caption: Click to display/hide captions. Caption text can be
copied by dragging it into the World Book Notepad or similar
word processor. You can double-click any word in a caption to
open the Dictionary to the word’s definition.

Go to Article: Click to go to the article associated with the
media element in use.

Browse Media: Click to display/hide the Browse Media
window.

• Click the disclosure triangle next to Advanced View to
restrict the types of media that are shown in the Browse
Media window.

• Click the Current tab to browse all the media associated
with the article in view before you moved to the Media
Center, or the current Time Frame or Just Looking
search.

• Click the All Installed tab to browse all media from
World Book that has been installed on your computer.

• Click the All On CD tab to view all the media on the
World Book Media CD that came with your computer.

• You can install the contents of the World Book Media CD
on your computer by selecting Install Media CD
Contents from the World Book application menu. You
will then be able to view all World Book media without
using the CD. After you have installed the Media CD
contents a single All Media tab will replace both the All
Installed tab and the All On CD tab.

Overlays: Click to use any overlays available for the media
element in use. The Overlays control will be dimmed if no
overlays are available.

Instructions: Click the Instructions control for guidance in
using all types of World Book media controls including:

• Sound controls: Clicking a sound icon plays the sound.
If there is not a corresponding picture to go with the

sound, the Media Center player will open. Pictures that
contain sound icons will appear with a sound control
strip beneath them. Both the Media Center player and
the sound control strip can be used to start, pause, and
resume playing the sound and to adjust the sound level.
If there are several sound icons on a single picture, click
one of the icons to play the corresponding sound.

• Picture series slider: Series of pictures will be
accompanied by a sequence slider bar, showing the
number of pictures in the
sequence and the number of
the picture in view.

• Video controls: Drag the slider to advance or rewind the
video, or use the arrow buttons to the right of the slider to
go forward or backward frame by frame.

• Bubble View controls: Click inside a Bubble View
image and drag the cursor to navigate, or use the
compass point controls on the navigation bar. Click the
magnifying glass buttons to zoom in or out. If you see a
green window outline, click inside it to jump to a new
view. If you get to the bottom of the Bubble View, you
will see a Reset View graphic; click it to return to the
initial viewpoint.

Zoom in or out of a Bubble View by pressing the + or –
keys on your keyboard. You may also use the up/down and
right/left keys to navigate.

Using Drag-and-Drop with

World Book Media

You can use the drag-and-drop functionality that is built into
Mac OS X to copy most World Book media elements. Click a
media element to select it and drag it to an open document
window of an application that accepts graphics, such as
TextEdit or the World Book Notepad. World Book credits are
copied with the media element.

Pictures: You can use the drag-and-drop feature to copy
almost all photos and illustrations in the World Book media
collection. If a picture cannot be copied, you will see that the
Edit menu remains dimmed when you click the picture.
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Just Looking
Just Looking enables you to browse through the content of
World Book for ideas, much like flipping through the pages of
the paper edition. But Just Looking is also a powerful tool that
can be used to search for graphics and articles by theme or by
category and type of resource.

Just Looking Functions

By Category

Just Looking By Category allows you to browse by eight World
Book categories. Click the By Category control and then
click the magnifying glass Search control to view a random
sampling of articles and graphics. Make selections from the
pop-up Categories and Content menus to determine the
results. For example, you could select the category History
and set the content type to Sounds and get a selection of
excerpts from famous historical speeches.

Categories menu: Content menu:

• Geography • Animations

• History • Articles

• Humanities • Atlas

• Industry/Tech • Back in Time

• Life Science • Bubble Views

• Phys. Sci/Math • Media

• Recreation • Pictures

• Social Science • Sounds

• Special Reports

• Timelines

• Videos

Advanced Search: Click the bottom of the Just Looking
device to open an Advanced Search drawer. Type the first few
letters of the resource and then select it from the list. Double-
click to place it on the desktop. Click the Clear button to
make it easier to see the items you are selecting.

By Theme

Just Looking By Theme allows you to browse through the rich
World Book media collection by selecting interesting subjects
such as Dinosaurs, Explorers, European Painting, and
International Sports. Click the By Theme control and then
click the magnifying glass Search control to view a sampling of
World Book media. Make selections from the Themes and
Subjects pop-up menus to guide your tour. For example,
select On the World Stage from Themes and Famous
Women from Subjects to get a sampling of photos from World
Book articles from Mary Todd Lincoln to Sandra Day O’Connor.

Themes:

• Animal Kingdom

• Art & Architecture

• On the World Stage

• People in the Arts

• Sports & Recreation

Clear: Click to remove all thumbnails from the viewing
area.

Audio icons

Audio icons: Two types of audio features are available in Just
Looking.

• Listen Now icon: Appears as a rectangular gray button
in the upper left corner of some text
thumbnails. The sound attached to this type of
icon may be played without leaving Just

Looking, simply by clicking directly on the icon. If instead
you click the text in the thumbnail, you will be taken to
the Media Center and the sound will automatically start
playing there.

• Embedded Sound icon: Appears as a white rectangle
embedded in one of the corners of a picture
thumbnail. The sounds attached to these icons
may be played only in the Media Center. Click
once anywhere on the thumbnail to go to the
Media Center, where you will see a full-size

version of the media element; then click the embedded
icon or use the sound control to play the sound.

To find out what topic corresponds to a particular
thumbnail, pass your cursor over the thumbnail and read
the text that appears in the Status Area at the bottom of the
Just Looking window.
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Just Listening
Just Listening enables you to explore the World Book music
content and other sounds by theme while media from the
same theme floats by on the Home Screen “waterstream.”
Click the Just Listening icon on the Home Screen to open the
Just Listening player. Then select a Theme and enjoy!

Controls

• Themes: Choose one of the themes from the pop-up
menu and listen to the selections (shown here in the
order they appear):

• Music sampler

• Classical music

• Opera

• Jazz

• Rock music

• Country music

• National anthems

• Songs from Europe

• African music

• Asian music

• Middle Eastern music

• Latin American music

• Music from the islands

• Animal noises

• Bird calls

• Sound Level: Click and drag the slider to set the sound
volume. This setting will not affect sound levels in other
areas of World Book.

• Just Listening Player Controls: There are three
control buttons at the bottom of the player window:
Previous Sound, Stop/Play, and Next Sound. Use these
buttons to control the sound playback.

• Display Area: Click the “Now Playing” display area to go
to the Media Center for more information about the
current sound. If a bird call is playing, for example, you
will see a picture of that kind of bird in the Media Center;
for a national anthem, you will see the flag of that country
displayed.
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Atlas
Atlas opens with a map of the world. Begin your review of
World Book maps by clicking any continent label; then
continue clicking to view progressively more detailed maps, in
order to see countries, states, provinces, and cities.

Atlas Functions

Zoom Out: Click to move to progressively larger-scale maps
containing the originally selected map.

Legends and Overlays: The Atlas device displays a legend
for every map and contains a pop-up menu for overlays which
are available for many countries and for all continents except
Antarctica. When a map is selected for which there are
overlays, the pop-up menu shows which overlays are
available. These may include population density, climate,
average temperatures, annual precipitation, agriculture and
fishing, mining and manufacturing, terrain, and economy.

Map Search: Click the Map Search control or click the
bottom of the Atlas device to open the Map Search drop-
down window. Start typing the location you are looking for in
the search field and the list scrolls to the closest map title.
Double-click an item in the list or complete typing the
location and press the Return key.

Drag-and-Drop Tip:  You can drag a place name from
an article, caption, or Surf the Ages Web page to the Atlas
icon on the toolbar to start a map search and go to the
Atlas area. The closest matching map will appear.

Go to Article: Click to go to the article associated with the
map in view.

Hotspots: Map hotspots are identified by a change in the
cursor icon to one of these three:

Zoom in: Click to reveal a more detailed map.

Article: Click to go to an article corresponding to the
map in view.

Related media: Click to go to a photo or other media
corresponding to the hotspot.

Drag-and-Drop Tip:  All of the maps in the World Book
Atlas can be dragged to an open document window of any
application that accepts graphics, such as TextEdit or the
World Book Notepad.

World Book Distance Calculator

The World Book Distance Calculator is part of the World Book
3D Atlas. It allows you to find out how far apart selected cities
are. Click the Distance Calculator control to launch the 3D
Atlas which will open to the Distance Calculator view.

Type the names of the two cities or select them from the
Location 1 and Location 2 drop-down lists. The globe will spin
to show both locations, and a red line linking them will
appear on the small flat map. The Distance Calculator also
displays the exact latitude and longitude of the selected
locations. Double-click the flat map to go to a larger flat map
view.

3D Atlas controls

View control: Use to select from the three
views: Distance Calculator view, Globe view,
and Flat Map view.

Spin control: Click the right or left arrow
of the Spin control to rotate the globe in

that direction. Click the center button to stop the globe from
rotating.

Clear button: Click to clear the location names.

Go to Map: Click to go to World Book to view the
corresponding World Book map in the Atlas area. If World
Book is not open, clicking Go to Map will launch it.

Day/Night button: Click to toggle day and night
time on the Globe or Flat Map.

Grid button: Click to display a latitude and
longitude grid on the 3D Globe.

Settings button: Click to open the settings drawer.
Globe settings include transparency, spinning speed,
the amount of shadow on the globe, and size of the
location markers. The size of markers may also be set for the
Flat Map view.

You can determine the latitude or longitude of any point
on Earth. Clear both location fields and then move the
cursor over the small flat map. The latitude and longitude
will appear in the Location 1 field.



W O R L D   B O O K   U S E R   G U I D E 14

Time Frame
Use Time Frame to locate information related to a specific
year, decade, century, millennium, or era. Time Frame results
are customized according to the choices you make. Some
articles contain specially prepared Timelines as supplements.

Time Frame Functions

Time Frame allows two methods of searching, by Time Period
or by Era. When searching by Time Period, you enter a specific
Time Frame, measured in years, decades, centuries, or
millennia. You may customize a Time Period search by
selecting a Category. When searching by Era, you select from
one of the preset eras, such as The Cold War or The American
Revolution.

Searching by Time Period

Select Time Period in the view control at the top of the Time
Frame device. Then enter a year and choose one of the
following from the Time Period pop-up menu:

• Year

• Decade (10 years)

• Century (100 years)

• Millennium (1,000 years)

Time Frame will assume you are entering years that are A.D.
(default) unless you select B.C. If you select a period other
than Year after typing a date, the date will be reset to reflect
the selected time period. (For example, if you type 1952 and
then select Decade, the date will be reset to 1950.)

Use the arrow controls next to the date field to move forward
or backward in time by increments corresponding to the time
period selected. (For example, if Decade is selected, you will
move by periods of 10 years when using the scroll arrows.)

To focus your search, select a Category:

• Geography

• History

• Humanities

• Industry/Tech

• Life Science

• Phys. Sci/Math

• Recreation

• Social Science

Click Go or press Return to begin your search.

Searching by Era

Select Era in the view control at the top of the Time Frame
device. Then select an era from the Era pop-up menu:

• Aegean cultures: 3000–1200 B.C.

• Age of Reason: 1600’s–1700’s

• American Civil War: 1861–1865

• American Revolution: 1775–1783

• Ancient Egypt: 3100–1070 B.C.

• Ancient Greece: 800–338 B.C.

• Ancient Persia: 550–331 B.C.

• Ancient Rome: 509 B.C.–A.D. 476

• Byzantine Empire: 395–1453

• Cold War: 1940’s–about 1990

• European Exploration: 1400–1890

• French Revolution: 1789–1799

• Indians of Latin America: to 1532

• Industrial Revolution: 1700–1900

• Medieval Europe: 400’s–1500’s

• Mesopotamia: 3500–539 B.C.

• Mongol Empire: 1100’s–1294

• Prehistoric animals: to 3500 B.C.

• Prehistoric people: to 3500 B.C.

• Reformation: 1517–late 1500’s

• Renaissance: 1300–1600

• Romantic movement: 1700’s–1800’s

• Soviet Union: 1917–1991

• Space age: 1957–today

• World War I: 1914–1918

• World War II: 1939–1945

Click Go or press Return to begin your search.

Viewing Search Results

Search results for all Time Frame searches are displayed as
thumbnails. Click any thumbnail to go to the corresponding
article or media element. Pass your cursor over any thumbnail
to view a description of its subject in the Status Area at the
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bottom of the screen. Note that dates within the time period
you used in a Time Period search will appear in red in the
resulting articles.

New Time Frame

Click  to retrieve the Time Frame device
to perform another search.

Audio icons

Two types of audio icons are available in Time Frame.

• Listen Now icon: Appears as a rectangular gray button
in the upper left corner of some text
thumbnails. The sound attached to this type of
icon may be played without leaving Time

Frame simply by clicking directly on the icon. If instead
you click the text in the thumbnail, you will be taken to
the Media Center and the sound will automatically start
playing there.

• Embedded Sound icon: Appears as a white rectangle
embedded in one of the corners
of a picture thumbnail. The
sounds attached to these icons
may be played only in the Media
Center. Click once anywhere on
the thumbnail to go to the Media
Center, where you will see a full-
size version of the media element;
then click the embedded icon to play the sound.
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What’s Online
World Book's extensive online functionality can be accessed in
the What’s Online area: Article Updates, historical articles,
Special Reports, and other timely information from the
Internet. Click the icon of a feature on the What’s Online
screen to select it.

What’s Online Functions

Update Now: Updates are posted regularly that
may be downloaded and added to your copy of
World Book. Click Update Now to automatically

retrieve any new Article Updates and updates to Month in
Brief, Back in Time, Special Reports, and Web Sites. When the
Update Now process is started, a dialog with a progress bar
will appear to show the status of the download.

• Notification of online updates. You do not need to
guess when online updates will be available. World Book
automatically checks for updates every time it is
launched when you are connected to the Internet—and
once a day afterwards for as long as it is running. If an
update is found, the World Book dock icon will begin to
spin and you will be notified by a dialog suggesting that
you run Update Now.

You can click the spinning dock icon and select Update
Now from the pop-up menu list to update your copy of
World Book.

You may turn off automatic update checking and
notification on the Updates pane of World Book
preferences.

Article Updates: Click for a list of World Book
updates that have been posted since the World
Book 2003 Edition was created. Double-click any
Article Update to view it in the Article area.

The Month in Brief: Click for a calendar with
summaries of the major news events of each day of
the month. Click a date on the calendar to view the

top news for that date. Click the right or left arrows on the left
side of the calendar to move one month at a time, or jump to
a different year.

The up and down arrow keys can be used to scroll
through the events displayed in Month In Brief.

Drag-and-Drop Tip: You can drag most news event
pictures from Month In Brief into an application that accepts
graphics, such as TextEdit or the World Book Notepad.

Web Sites: Click to explore Web sites reviewed
and approved by World Book editors. Enter search
terms in the entry fields (for example, “Apple” and

“Computer”) and press Return to start the search. Click any
underlined Web site in the results list to go to that site.

Back in Time: Click to download historical articles
from World Book’s chronological annotated online
archives. Select a topic from the drop-down menu
and then double-click a year to start retrieving the Back in
Time article. A dialog will open with a progress bar to show
the status of the download. When the download is complete,
the article will be displayed in the Article viewing area. Each
downloaded article is permanently added to your copy of
World Book.

Special Reports: Click to browse the Special
Reports collection, prepared by World Book editors
to supplement the Encyclopedia articles. Narrow

your search by selecting one of the eight World Book topic
categories: Geography, History, Humanities, Industry and
Technology, Life Science, Physical Science and Math,
Recreation, and Social Science. Double-click a report to start
retrieving it. A dialog will open with a progress bar to show
the status of the download. When the download is complete,
the article will be displayed in the Article viewing area.

World Book on the Web: Click to go to the
World Book Web site, where you will find
educational resources for parents, students, and
teachers. A dialog will appear letting you know that you are
about to leave World Book to go to World Book’s Web site on
the Internet. When you click OK or press Return, your Web
browser will launch and the Home Page of the World Book
Web site will be displayed.

Note: World Book takes no responsibility for the content or
practices, including usage fees, if any, for any Web sites
operated by independent organizations.

Note: The Update service may be suspended without notice
to you.
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Surf the Ages
Surf the Ages is an imaginative and historically accurate look
at the past 5,500 years, presented as if the Internet had existed
when, for example, Plato and Aristotle debated the Socratic
method; a broken-hearted shah built the Taj Mahal; and a
determined Florence Nightingale changed the face of modern
medicine.

Each time period, from 3500 B.C. to the A.D. 1900’s, has its
own home page that links to other imaginary Web sites from
that period. Users access them with an offline Web browser
built into this edition of World Book.

Choose Surf the Ages from the Home Screen, from the Go
menu, or click the Surf icon on the Toolbar for five and a half
millennia worth of simulated Web sites. Check out what some
Web news sites might have been like if the Web had existed
since ancient times.

Surf the Ages Functions

Choose Ancient Times, Middle Ages, or Modern Times from
the Surf the Ages Home Screen to begin surfing. Then choose
from the four or five time periods for each Age to view
centuries of home pages full of Web features such as e-zines,
want ads, bookstores, and other types of imaginary Web sites.

View from Today: Although the Surf the
Ages Web sites are fanciful, the material they
contain is based on fact. Use the View from
Today button or link to learn what we now know or think
about a featured event, person, or idea, and to get links to
World Book articles, book lists, and actual Web sites.

 Drag-and-Drop Tip: To get the real story about many
historical characters, select and drag their names to the
Search icon on the Toolbar and the World Book article
about them will appear in the Article viewer. You can also
drag any place name found in Surf the Ages to see the
closest real World Book map.

Printing and copying: You can print all of the Web pages in
Surf the Ages and copy any of the selectable text.
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Notepad
World Book Notepad is a simple but customizable word
processing application, included with the World Book 2003
Edition. The World Book Notepad allows you to easily create
documents using text and graphics from World Book.

Launch Notepad either by choosing World Book Notepad
from the Tools menu of the main World Book application or
by double-clicking the Notepad application icon located in the
World Book 2003 folder.

World Book Notepad Functions

Customizing the toolbar: Unlike most simple
word processing applications, the Notepad has a
customizable Toolbar, which allows the user to

enhance its features, creating a more advanced word
processor for more experienced users. Click the Customize
icon on the toolbar to open the Customize dialog. Drag
controls from the dialog into the Toolbar to add them, or drag
them off the Toolbar to remove them. Drag the default set of
controls to the Toolbar to reset the default Notepad toolbar
arrangement.

Switching to other World Book applications: You can
switch back and forth easily between Notepad and the World
Book 2003 Edition. When you are using the Notepad, just click
the World Book icon on the Notepad Toolbar to go to World
Book. Return from World Book to the Notepad using the
shortcut Command + N. This can be very useful if you are
collecting materials from World Book to use in a report. You
can also add icons for the four Wizards to the Notepad toolbar
using the Customize dialog.

Drag-and-Drop Tip: Drag the selected text from
articles, captions, tables, and dictionary from the  World
Book 2003 Edition into any open Notepad document. You
can also drag most media elements such as maps, pictures,
and timelines into an open World Book Notepad document.

Saving Notepad documents: When saving a World
Book Notepad document, you can choose between
three available formats:

• World Book Notepad Format (“.wbn”): This format,
the default for World Book Notepad documents, is a
derivative of .rtfd, a format which saves documents with
both pictures and text. Unlike .rtfd TextEdit documents,
however, Notepad .wbn documents support page breaks,
page numbers, and headers and footers. As a result, files

with the .wbn extension can be opened only by the
World Book Notepad.

To open a Notepad document in other applications
without losing the pictures you have placed, you can
change the extension manually from .wbn to .rtfd. The
document will then open in TextEdit and other applications
that support .rtfd format though special Notepad
formatting, such as page breaks, will be lost.

• Standard Rich Text Format (“.rtf ”): This is a standard
format which can be opened in most word processors,
while retaining text style, alignment, and color. Saving
your Notepad document in this format will allow it to be
read easily in most word processors such as Word,
AppleWorks, and TextEdit.

• World Book Text Format (“.wbt”): This is the simplest
text format. It can be opened in any other word
processor but does not retain any formatting.

Formatting your document:

• Inserting page breaks: Place your cursor where the
page break is needed and choose Insert Page Break
from the Format menu.

• Page numbering: Choose Page Numbers from the
Format menu and set the starting page, position, and
alignment of the page numbers.

• Inserting headers and footers: Choose Header and
Footer from the Format menu, click the Header and/or
Footer checkboxes, and type in the text you want to
appear on every page of your Notepad document. You
may also set the alignment of your headers and footers.

• Show margins: “On” by default, leave this option
selected in the Format menu to show your document the
way it will appear when you print it.

Using Apple Services: Because the World Book Notepad is
a native Mac OS X application, you can use standard Apple
Services by selecting Services from the World Book Notepad
menu. For example you can have the text in your Notepad
document turned into an e-mail, opened in a TextEdit
document, or even placed automatically on a sticky note.

Spellchecking: Choose Spelling from the Edit menu to use
the built-in Apple dictionary to check the spelling of your
World Book Notepad document. To have spelling checked as
you type, select Check Spelling As You Type from the Spelling
submenu.



W O R L D   B O O K   U S E R   G U I D E 19

Adding Graphics: To insert a photograph or other graphic
image into your Notepad document, choose Import Graphics
from the File menu. From the Open dialog that appears, select
the graphic file you want to place. By default, you will be given
a chance to change the image size before it is placed on the
page. You may also add a graphic image without changing its
size using drag and drop or by copying and pasting it from the
Clipboard.

Resizing Graphics: To change the size of a graphic image
that has already been added to a Notepad document, just
double-click it and adjust the size using the slider on the sheet
that appears. To change the size proportionally, leave the Keep
Proportions checkbox checked. Click the Reset Scale button
to go back to your previous size settings. To make large
pictures fit the current page size, click the Fit to Page button.
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Speech
With the speech capabilities of World Book, you can navigate
using voice commands, or you can find any article in World
Book and have it read to you.

Note: To use World Book’s Speech Capabilities, you first need
to turn on Mac OS X Speech Recognition. In System
Preferences, open the Speech Preferences pane. Click the
Speech Recognition tab and then, in the On/
Off pane, turn on the Apple Speakable Items
option; the round Feedback Window will
appear. While still in the On/Off pane, click
the Helpful Tips button for some useful advice.

Tips for using speech capabilities

• Hold down the Esc key while giving commands and then
immediately let it go.

• Don’t crowd the microphone. For best results, sit two
feet away.

• Shut off the music on the home page or switch to the
article area before giving a command. Silence is best if
you want to use voice commands.

Launching World Book by voice command

You can start World Book using voice commands. Press and
hold down the Escape key, say “Hello World Book,” and
release the Esc key. World Book will launch.

Find an article and have World Book read

it to you

Here’s a typical search you can do. In this case the user
searches for an article about “cats” but you can search for any
of the more than 18,000 articles in World Book.

YOU: “Search, please.” (Remember to hold down the Esc key
while speaking.)

WORLD BOOK: [opens search window] “Ready to Search!”

YOU: [type “cat” and press the Return key]

WORLD BOOK: “Searching for cat.”

WORLD BOOK: [plays cat “Meow!” sound at top of the article]
“Search complete!”

YOU: “Read to me...”

WORLD BOOK: [Starts reading the Cat article aloud]

Controlling article reading

Once World Book starts reading an article, you can use
keyboard commands (or commands from the Speech
submenu in the Edit menu) to control the process:

Speak Article Text: Command + Comma

Speak Selection: Option + Command + Comma

Stop Speaking: Command + Period

Pause Speaking: Shift + Command + Period

Continue Speaking: Shift + Command + Comma

Troubleshooting

If the speech recognition features in World Book do not
appear to be working, it may help to turn Speakable Items off
and then on again in the Speech Preferences panel of System
Preferences. If this doesn’t correct the problem, open the
Speech pane of World Book Preferences and click the Help
button for additional tips on using World Book Speech
Capabilities.
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Homework
Wizards
The four Homework Wizards are designed to engage students
structurally in doing research and writing reports, and to help
them use their computers and World Book creatively.
Onscreen prompts enable the student to concentrate on the
task rather than on navigating the software. To get started,
click the Homework Wizards icon on the Home Screen or
Wizards icon on the Toolbar, or select Homework Wizards
from the Tools menu.

Report Wizard

Report Wizard provides step-by-step guidance in all the
aspects of report writing: selecting a topic; preparing a
schedule; doing research and preparing notecards; choosing
an approach; writing a thesis statement; sorting notecards;
writing an outline; writing the first draft; creating visuals;
revising; preparing a bibliography; and preparing the final
paper.

The first choice you have in the Report Wizard window is
between New Report and Existing Report. If you choose New
Report, you’ll see a Save File sheet asking for a report name.
Entering the report name allows the application to
automatically save all your work. The Report Wizard Menu
appears next; click any item in the Report Wizard Menu to do
that step. A checkmark next to a step shows that you’ve
already completed it for an Existing Report, but you can return
to it to make changes.

Whenever you click Print in Report Wizard, you’ll see a menu
of items from which to choose. You may also choose to print
helpful pointers about the current step in the report writing
process. Click Next or Back at the bottom of Report Wizard
windows to complete a choice and continue or to return to
the previous step. Click Done to leave the step you are
working on.

Step 1: In the Select a Topic window, click No if you want to
type a topic you’ve already chosen, or click Yes to get some
help in choosing a topic.

Step 2: The Make a Schedule window contains a calendar in
which you can set a due date for each part of your project. Use
the arrows at either side of the month to move forward and
backward by month in the calendar.

Step 3: When you choose Do Research and click Go to
World Book, the Report Wizard automatically searches World
Book for information related to your topic, and retrieves the
most relevant article.

Step 4: In the Choose an Approach window, you choose
from a list of different approaches for presenting the material
in your report and get advice on the various options.

Step 5: In the Write a Thesis Statement window, you see
some sample thesis statements reflecting the Approach you
chose, and can type in your own thesis statement. (If you
didn’t choose an Approach, the program will display
Descriptive thesis statements.)

Step 6: In the Sort Your Notecards window, there is advice
on how to sort the notecards you create during your research.

Step 7: In the Write an Outline window, there is advice on
writing an outline for the approach you’ve chosen and an area
to prepare your outline. Press Tab to indent a line in your
outline; press Return to move down one line.

Step 8: In the Write Your First Draft window, you create a
file for your first draft. You’ll then begin working with your
word processor, but the Report Wizard will continue to deliver
advice.

Step 9: From the Create Visuals window, you can go to the
Chart or Timeline Wizards. See the next sections for more
information about these Wizards.

Step 10: In the Revise Your Paper window, you can print a
checklist of items to review in your report.

Step 11: In the Create a Bibliography window, you can
prepare a bibliography.

Step 12: In the Prepare Your Final Paper window, you can
print advice on how to format and finish your report.

Chart Wizard

Chart Wizard enables you to quickly and easily create and
print a chart or graph, or to add a chart or graph to a report or
presentation. Using Chart Wizard, you can create horizontal
bar and vertical bar charts, line graphs, and pie charts. Click
Next or Back at the bottom of Chart Wizard windows to
complete a choice and continue or to return to the previous
step.

The first choice you have in Chart Wizard is between New
Chart and Existing Chart. If you choose Existing Chart, you’ll
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see a sheet asking for a chart name. The Choose a Chart Type
window appears next; click the type of chart you want to
create.

In the Choose a Comparison window, click the type of
comparison you want to use in your chart; click Other to
enter a comparison different from those listed in the window.

In the Select Unit of Measurement window, you see units
of measure appropriate for the type of comparison you chose.
Click a unit of measure. If you chose Quantity as your type of
comparison, the program will skip this window and take you
directly to the Comparison Table window. If you chose Other,
a window appears in which you can specify what you are
comparing and the unit of measure to be used. Use the pop-
up menu for suggestions of units of measure, or type a
different one.

In the Comparison Table window, you use a two-column
table to enter the labels and amounts that will appear in your
chart. The unit of measure you selected will be shown in the
column on the right. Use the Sort buttons to arrange the
items in alphabetical or reverse alphabetical order, or
ascending or descending order.

In the Chart Title window, you are shown your chart for the
first time. Use the text entry box to change the chart title if
you wish.

In the Font window, there is a pop-up list of the fonts
available for the text in your chart.

In the Color or Pattern Selection window, you can choose
the colors and patterns for the different segments of your
chart. Click either the Colors or Patterns radio button to
choose colors or patterns. To change the color or pattern of a
segment in your chart, first click the chart segment, then click
the color or pattern you want for that segment.

In the Final View window, you see your completed chart.
Click Save and follow the prompts to choose a folder, name
the file, and save it. The Chart Wizard creates a picture file
(.PICT) that can be inserted into reports or presentations. The
Chart Wizard also creates a Chart Table that allows you to edit
the chart from within the Chart Wizard.

Drag-and-Drop Tip: You can drag your completed
chart or graph to an open document window in any
application that accepts graphics, such as TextEdit or the
World Book Notepad.

Timeline Wizard

Timeline Wizard enables you to quickly and easily create and
print a Timeline, or add a Timeline to a report or
presentation. The Timelines you create can contain events
and dates you specify, or events and dates found in a special
World Book events database. Click Next or Back at the bottom
of Timeline Wizard windows to complete a choice and
continue or to return to the previous step.

The first choice you have in Timeline Wizard is between New
Timeline and Existing Timeline. If you choose Existing
Timeline, you will see a sheet asking for a Timeline name and
file location. The Timeline View window appears next; choose
between Banner and Compact styles.

Note that the Timeline Wizard creates a picture file you can
paste into other documents only for Compact Timelines.
However, both banner and compact timelines can be dragged
directly into your report.

Drag-and-Drop Tip: You can drag your completed
compact or banner Timeline to an open document window
in any application that accepts graphics, such as TextEdit
or the World Book Notepad.

The Enter Events window contains a table you can use to
enter events and dates for your Timeline.

 Use the Tab key to advance from element to element in
each row, and use Shift+Tab to go back.

You can get instructions on filling in all the elements of the
events table by clicking Instructions. Then select an element
from the pop-up menu at the top of the Instructions window
to view the instructions about it.

 Click any element in the event table before clicking the
Instructions button, and the Instructions window will open
to show instructions about that element.

You can delete an event by clicking the row number of the
event and then clicking the Delete Event button.

When you click Search in the Enter Events window, a Search
for Timeline Events window appears. Enter search words,
combining them as desired using the pop-up menu, and click
Go to search a special World Book database of events. To
select an item from the Results box for your Timeline, click it
to highlight it, then click Select Events. To select all the items
in the Results box, click Select All.
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Click Select Events and then OK to add the list of events
you’ve selected to your Timeline. Then click Next, and your
Timeline appears in the Change the Title or Font window.
You can change the Timeline title, if you wish, and select a
new font from the pop-up font list.

In the Add a Picture window, click Pictures for a scrollable
list of picture descriptions. Select a picture description to see
a preview of the picture; click OK to attach the selected
picture to the Timeline title.

In the Final View window, your completed Timeline is
shown. Click Save, and follow the prompts to choose a folder,
name the file, and save it. For Compact-style Timelines,
Timeline Wizard creates a Timeline Picture File that can be
inserted into reports or presentations. The Timeline Wizard
also creates a Timeline Table File that allows you to edit the
Timeline from within the Timeline Wizard. If you want to
create another Timeline, click New Timeline.

Quiz Wizard

Quiz Wizard enables you to make and take three different
types of quizzes—to challenge yourself just for the fun of it, or
to practice for quizzes and tests you take in school.

You can make true-false and flash-card quizzes on any subject,
or create mathematics quizzes. Use the Advice buttons that
appear in some of the Quiz Wizard windows for tips on how
to get the most out of a particular Quiz Wizard feature. Use
the Print button to print out whole quizzes (questions and
answers; questions only; answers only), individual question
and answer, Advice screens, or Quiz Score screens.

Make or Modify Quiz

The first choice you have in Quiz Wizard is between Make or
Modify Quiz and Take Quiz. If you choose Make or Modify
Quiz, a window will appear where you can choose between
New Quiz and Existing Quiz.

If you choose New Quiz (meaning that you want to make a
new quiz), the Save File sheet will appear; entering the quiz
name allows the program to save all your work automatically.
Then go to the Choose Quiz Format window and select True-
False, Flash Card, or Mathematics. After you choose a format,
you’ll go to the Quiz Manager window for the type of quiz
you’ve selected.

 When making mathematics quizzes, you can use your
mouse to click numbers on an onscreen calculator keypad,
or you can use the number keys on your computer
keyboard.

If you choose Existing Quiz (meaning you want to make
changes to a quiz you’ve made before), select the filename of
the quiz you want; you’ll then go to the Quiz Manager
window for that quiz.

There are Advice, Quiz Manager, and Question/Answer Entry
windows for each of the three types of quizzes. Advice gives
you some pointers in using the type of quiz you’ve selected.
Quiz Manager enables you to make, change, or delete items
for new and existing quizzes.

When you choose to make or change a quiz item, you’ll go to
a Question/Answer Entry window that will take you through
the steps to make or change an item. Deletions are made
from within the Quiz Manager window. Items in an existing
quiz will be listed in the Quiz Manager window.

When you take a quiz you’ve made, you’ll be shown all the
items you created in that quiz. Keep this in mind when you’re
making quizzes, and create only as many items as you’ll want
to be quizzed on. When you’ve made all the items you want in
a quiz, click Done, you’ll then have the option to take the quiz
right away. If you decide not to take the quiz, then you may
make another one or quit Quiz Wizard.

Take Quiz

If you choose Take Quiz, a sheet will open from which you
can select an existing quiz. After you select a quiz, an
introduction appears showing the number of items in the quiz
and the steps to follow in taking that particular type of quiz.
You’ll then move on to the quiz items, one by one. Click Next
to find out if your answer is correct, and to move on to the
next quiz item.

You have two chances to complete each quiz item correctly in
the flash-card and mathematics quizzes; in true-false quizzes,
naturally, there’s only one chance. When your answer is
correct, simply click OK to go to the next item. If your answer
is incorrect, you can try again or choose to see the correct
answer. You also can skip any item in the quiz you’re taking.
The quiz items will appear in random order instead of the
order in which you entered them.

You will see your score after you have done all the items in a
quiz. You can repeat the quiz right away, simply review all the
items in the quiz, or quit the Quiz Wizard.
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